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Minnesota Statute 115.03, subdivision 5c, paragraph c, states, “The agency shall develop performance standards, design standards, or other tools to enable and promote the implementation of low-impact development and other storm water management techniques. For the purposes of this section, ‘low-impact development’ means an approach to storm water management that mimics a site’s natural hydrology as the landscape is developed. Using the low-impact development approach, storm water is managed on-site and the rate and volume of predevelopment storm water reaching receiving waters is unchanged. The calculation of predevelopment hydrology is based on native soil and vegetation.”

Through the implementation of this statute, Minimal Impact Design Standards (MIDS) runoff volume performance goals were developed by the MIDS Work Group.  The Work Group recommends three standards, depending on the type of development. For new, nonlinear developments that create more than one acre of new impervious surface on sites without restrictions, the Work Group recommends that stormwater runoff volumes be controlled and the post-construction runoff volume be retained on site for 1.1 inches of runoff from impervious surfaces statewide. For redevelopment sites, the MIDS Work Group recommends that nonlinear redevelopment projects on sites without restrictions that create one or more acres of new and/or fully reconstructed impervious surfaces capture and retain on site 1.1 inches of runoff from the new and/or fully reconstructed impervious surfaces. For linear projects on sites without restrictions that create one acre or greater of new and/or fully reconstructed impervious surface, the Work Group recommends that sites capture and retain the larger of 0.55 inches of runoff from the new and fully reconstructed impervious surfaces or 1.1 inches of runoff from the net increase in impervious area. None of these goals is time dependent; instead they are instantaneous. This means that a best management practice (BMP) must retain the required volume whether it occurs in half an hour or over 12 hours.

All projects must first attempt to meet the stormwater volume reduction performance goal described above. However, if an applicant is unable to achieve the full performance goal due to site restrictions, as attested by the local authority and documented by the applicant, a Flexible Treatment Options approach can be followed in the sequence on site. The first Flexible Treatment Option includes, in general, retaining on site at least 0.55 inches of runoff from impervious surfaces and removal of 75% of the annual total phosphorus (TP) load leaving the site. The next Flexible Treatment Option includes, in general, stormwater runoff volume reduction to the maximum extent practicable (as determined by the local authority) and removing 60% of the annual TP load. Off-site mitigation (including banking, cash, or treatment on another project as determined by the local authority) equivalent to the volume reduction performance goal can be used for compliance. However, off-site mitigation and banking credits must protect the receiving water.  

To assist designers and regulators in determining conformance to the MIDS performance goals, a MIDS BMP calculator was developed as a tool to determine volume and pollutant reduction capabilities of various low impact development (LID) BMPs. The MIDS calculator estimates BMP volume reductions based on the 1.1 inches (or 0.55 inches) of runoff off impervious surfaces and annual pollutant load reductions for total phosphorus (including a breakdown between particulate and dissolved phosphorus) and total suspended solids (TSS). 
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The user first needs to make sure that and previous version of the MIDS calculator has been uninstalled from the computer. Next, the user needs to install the calculator by downloading the files. Both the installer package (MIDSCalculatorGUIInstaller.msi) and the setup file (setup.exe) need to be located in the same folder.  The user needs to run the setup file to start a standard Windows install package.  Below is first screen that will appear after running the setup file.

[image: ]

The install program will ask for a folder to store all files.  The default folder will be \Program Files\MIDS Calculator GUI\

[image: ]

After the installation is complete, a shortcut to run the program will appear on the desktop as shown below.
[image: ]
The MIDS Graphical User Interface (GUI) calculator requires Excel 2003 or later to be installed.  The calculator also required Microsoft .Net Version 4.0 framework.  If this is not already installed on the workstation, it will be downloaded from the internet and automatically installed during the installation process.
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When the MIDS GUI calculator starts, the following screen is displayed:
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Two menus appear in the upper left hand corner of the GUI: File and Help.

If the user selects the Help menu the following menu will appear.
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The choices in the Help menu are as follows:

User’s Guide: This will take you to a link where you can download this User’s Guide.

MIDS Overview: This will take you to the section on MIDS in the Minnesota Stormwater Manual Wiki.

If the user selects the File menu the following menu with appear.

[image: ]
The choices in the File menu are as follows:

New: Opens a new model.

Open: Displays the dialog for opening an existing model.  The existing Excel model must say “Minnesota MIDS Calculator -- Version 2: June 2014” at the top of the Site Information and Summary worksheet.  An error will appear if the user tries to open an older version of the Excel based calculator through the GUI program.

Save: Allows the user to save a model using the existing file name. This menu item becomes active once a new or existing model is opened.

Save As: Opens the dialog for saving a model in a different location or under a different file name. This menu item becomes active once a new or existing model is opened.

Print: Allows the user to print the Results tab. This menu item is only active then the Results tab is active.

Close: Exits and closes the program. If a model is open, this action will ask the user if they would like to save the current model before closing.

If New is selected in the File menu, a dialog will appear asking to user to select a save location as well as a file name. 
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When those two items are entered, a new model with be created and the following screen will display:
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The largest part of this screen is occupied by a set of tabs with the following three tabs choices:

Site Information: This is the tab that is active when a model is first opened. The user can enter information into the model pertaining to the entire site being examined. Further details about this tab are discussed in Section 3.2.

Schematic: This tab is where the graphical depiction of the model is created. It is the area where the user will add BMPs to the model, enter BMP specific parameters, and route BMPs to one another. This is where model building and manipulation tasks will be executed. Further details about this tab are discussed in Section 3.3.

Results: This tab will display a summary of the model results. Further details about this tab are discussed in Section 3.5.

The left hand column contains Summary Information about the model. This information is filled in and updated as the model is created providing the user with information on how the modeling is meeting the performance goal requirements for both volume and pollutants.
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3.2 Site Information Tab
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The Site Information tab is the first tab that is active when a new or existing model is opened. This tab is used to enter project specific information as well as information pertaining to the entire site being modeled. Cells with a white background designate parameters that can be entered by the user. Cells with a grey background designate parameters that are automatically calculator and cannot be filled in by the user. Parameters in this tab include:

Project Name: Input for the name of the project. No formatting is required. This field is optional.

User Name/Company Name: Input for a user of company name or the user creating this model. No formatting is required. This field is optional.

Date: Input for the user to enter in a date the project was created. No formatting is required. This field is optional.

Project Description: Input for the user to enter in a project descriptions. Multiple text lines are allowed. No formatting is required. This field is options.

Volume Retention Requirement: The runoff volume performance goal requirement. The default value is 1.1 inches off of impervious surfaces. This value can be changed to another positive numerical value (e.g., 0.55 if flexible treatment options are being applied). If this value is changed, red text will appear both in the Summary Information tab and the Results tab informing the user that it has been adjusted. 

[image: ]
 
Site Zip Code: Requires a five digit Minnesota zip code to be entered. Minnesota zip codes range between 55001 to 56763. This value is used to lookup annual rainfall amounts to calculator annual phosphorus and TSS loads. A value is required in this field in order to continue to another tab in the model.

Annual Rainfall: This is a calculated field and can only be changed by entering a different zip code in the Site Zip Code field. Annual rainfall amounts are calculated based on zip codes using the normal annual precipitation values reported by the Minnesota Climatology working group in 2003 (http://climate.umn.edu/img/normals/precip/precip_norm_annual.htm).

Phosphorus EMC: Input for annual average phosphorus event mean concentration (EMC). The default value is 0.3 mg/l which is the average concentrations for residential and multi-family residential areas reported by Pitt et al. 2004. This value, combined with calculated annual runoff volumes, is used to determine annual phosphorus loads from the site. This value can be changed to another positive numerical value. If this value is changed red text will appear both in the Summary Information tab and the Results tab informing the user that it has been adjusted. 

[image: ]

TSS EMC: Input for annual average TSS event mean concentration (EMC). The default value is 54.5 mg/l which is the average concentrations for various land uses reported by Lin, 2003. This value, combined with calculated annual runoff volumes, is used to determine annual TSS loads from the site. This value can be changed to another positive numerical value. If this value is changed red text will appear both in the Summary Information tab and the Results tab informing the user that it has been adjusted.

[image: ]

Forest/Open Space Land Cover: Input for site area covered in forested/open space land cover. This land cover includes undisturbed areas, protected/open space or reforested land.  This includes any forested or open space area protected during construction and that will remain undisturbed or will not be routinely mowed, but instead left in a natural vegetative state. Land cover is divided into four soil types (A, B, C, and D). All values should be entered in units of acres. Values are used to calculate annual pollutant loads from the entire site.

Managed Turf Land Cover: Input for site area covered in managed turf. This land cover includes any disturbed area, graded for yards or other turf to be mowed/managed. This includes any turf areas that are intended to be mowed and maintained as turf within residential, commercial, industrial, institutional settings, and road right-of ways. BMP surface areas should also be included in this classification except for green roofs, permeable pavement constructed wetlands, and constructed stormwater ponds. Land cover is divided into four soil types (Hydrologic Soil Group A, B, C, and D). All values should be entered in units of acres. Values are used to calculate annual pollutant loads from entire the site.

Impervious Area Land Cover: Input for site area covered in impervious land use. Impervious land cover includes surfaces that prevents the infiltration of rainfall and results in an increased volume of surface runoff.  This includes roadways, driveways, rooftops, parking lots, sidewalks, and other areas that replace an otherwise pervious surface.  A green roof and permeable pavement should be entered as impervious surface. All values should be entered in units of acres. Values are used to calculate the volume reduction performance goal requirement and annual pollutant loads from the entire site. A value is required in this field in order to continue to another tab in the model.

Note: Water surface areas for wetlands and stormwater ponds should not be included as a landcover in the calculator.  The calculator uses the conservative assumption that precipitation and evapotranspiration at the surface of these systems are neutralizing and that pollutant load additions from precipitation alone minimal. 
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3.3 Schematic Tab
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This Schematic tab is where the graphical depiction of the model is created. It is the area where the user will add BMPs to the model, enter BMP specific parameters, and route BMPs to one another. When moving from the Site Information tab to the Schematic tab, the Summary Information will automatically update. The left hand side of the Schematic tab is the icon toolbar. This toolbar contains icons for the 16 BMPs that can be added to the model. A label containing the BMP type will appear if the curser is positioned over the BMP icon as shown below:

[image: ]

All 16 BMP types and the associated icons are listed below:

	BMP Type
	BMP Icon
	BMP Type
	BMP Icon

	Green Roof
	[image: ]
	Swale main channel
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	Bioretention basin (w/o underdrain)
	[image: ]
	Swale main channel (with underdrain)
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	Bioretention basin (with underdrain)
	[image: ]
	Wet swale
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	Infiltration basin/ Underground infiltration
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	Harvest and re-use / Cistern
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	Permeable pavement
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	Sand filter
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	Tree trench system/ Box (w/o underdrain)
	[image: ]
	Constructed stormwater pond
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	Tree trench system/ Box (with underdrain)
	[image: ]
	Constructed wetland
	[image: ]

	Swale side slope
	[image: ]
	Other (User Defined Reductions)
	[image: ]



The following actions can be initiated in the Schematic tab:

Adding BMPs to the model: To add BMPs to the model, the user must drag and drop the associated icon into the Schematic Window. This is done by placing the curser over the corresponding icon in the BMP toolbar. The user then left-clicks and holds the mouse button down while dragging the icon to the desired position in the schematic window. When the icon is in the correct position, the user can release the left-click and an icon will appear. A unique name will automatically be created for the BMP. The model only allows 10 BMPs of the same type to be added to the model for all BMPs except for Harvest and re-use/Cistern which only allows 2 BMPs of that type. An error will appear if more than 10 BMPs (2 for Harvest and re-use/Cistern) of any one type are added. An example model with three BMPs is shown below.

[image: ]

Selecting BMP icons: The user can select multiple BMPs in the Schematic Window by holding down the CTRL button while left-clicking on multiple BMPs in succession, or by creating a "selection box" by dragging the cursor from one point in the graphics pane (not on a BMP) to another point. When a BMP is selected, a box will appear around the icon as shown below.

[image: ]

Moving BMP icons: Moving BMP icons in the Schematic Window to a new location is conducted in a similar manor as adding BMPs. Place the curser over the icon. When the curser is over the icon the curser will change to an arrow facing in all four directions as shown below. When this happens, press and hold the mouse left-click and move the icon to the desired position. When the icon is in the correct location, release the left-click. If multiple BMPs are selected all BMP will be moved together.

[image: ]

Deleting BMP icons: Selected icons can be deleted from the Schematic Window by pressing the DEL key or through the items right-click menu as shown below. The right-click menu can be opened by placing the curser over the icon and pressing the right-click.
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Opening the BMP Properties window: In order to gain credit for the inclusion of a BMP in the model, BMP specific parameters need to be defined. This is done by accessing the BMP Properties Window. To access this window, the user can either double-click on the desired BMP to edit or select “Edit BMP Properties” in the right click menu for that BMP as shown below. Further discussion of the BMP Properties Window can be found in Section 3.4.

[image: ]
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3.4 BMP Properties Window

[image: ]

The BMP Properties window is used to edit parameters specific to the BMP selected. Three tabs can be selected in this window include the Watershed tab, BMP Parameters tab and BMP Summary tab. When the user is finished filling out the BMP data, clicking the OK button returns the user to the Schematic tab. 
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The watershed tab allows the user to change the following parameters:

BMP Name: The user can change the BMP name as long as the new name is not currently being used by another BMP in the model. No text restrictions for naming conventions are present.

Routing/downstream BMP: The user can select a BMP to route all excess volume and pollutants to through a drop down menu as shown below:

[image: ]

BMPs in the drop down menu are restricted to BMPs already placed in the model, and BMPs that would not create a circular reference (i.e., where the outflow from a BMP could be routed back to itself). Certain BMPs have other routing restrictions such as BMPs other than Green Roof BMPs cannot be routed to a Green Roof and Swale Side Slope BMPs can only be routed Swale Main Channel BMPs (i.e., Swale Main Channel, Swale Main Channel with an Underdrain, and Wet Swale). While multiple BMPs can be routed to a single BMP, a BMP cannot be routed to multiple BMPs. After selecting a routing BMP and exiting the BMP Properties window by pressing OK, an arrow in the Schematic Window will appear going from the selected BMP to the routed BMP as shown below:

[image: ]

Minnesota Stormwater Manual Wiki Link: This link will route the user to the Minnesota Stormwater Manual Wiki. The user will be routed to the section of the Wiki dedicated to the specific BMP type. The HELP button can also be used to take the user to the Stormwater Manual Wiki.

BMP Watershed Area: This section is used to define the watershed area that is routed directly to the BMP. This is used to subdivide the watershed area defined in the Site Information tab into subwatershed for each individual BMP in the model. 
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The BMP Parameters tab is where the user enters BMP specific design information. This tab will be different based on the BMP type. The different BMP Parameters tabs for each BMP type can be viewed in Appendix A. A description of the individual BMPs parameters for each BMP type will be available through Stormwater Manual Wiki and can be accessed through the Minnesota Stormwater Manual Wiki Link in the Watershed or through the HELP button. The BMPs that do not provide volume reduction (Wet Swale, Sand Filter, and Wetland) will not have a BMP Parameters tab. Cells shaded white are input cells, cells shaded grey cannot be changed by the user.  Three parameters are calculated for each BMP in the BMP Parameters tab. These three parameters are:

Required treatment volume: This volume is the required treatment volume based on the performance goal requirement. It is equivalent to the direct impervious watershed area defined in the Watershed tab of the BMP Properties window multiplied by the volume retention requirement (default value is 1.1 inches) defined in the Site Information tab plus any excess volume routed to the selected BMP from upstream BMPs. It is the amount of water this BMP is required to infiltrate in order to meet the MIDS performance goal requirement for volume reduction.

Volume reduction capacity of BMP: The volume reduction capacity of the BMP is calculated as the amount of water volume that the BMP is capable of removing/infiltrating based on the BMP parameters defined in the BMP Parameters tab. The calculation used to determine this value varies based on the BMP type. 

Volume of retention provided by BMP: The volume of retention provided by the BMP is equal to the amount of water volume reduction the BMP is actually providing in the model. This value is equal to the volume reduction capacity of the BMP, unless it is greater than the required treatment volume (i.e., the amount of water being routed to the BMP); in this case the value is set to the required treatment volume.
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The BMP Summary tab summarizes the volume and pollutant reductions provided by the specific BMP. It details the performance goal volume reductions and annual average volume, dissolved P, particulate P, and TSS load reductions. Included in the summary are the total volume and pollutant loads received by the BMP from its direct watershed, from upstream BMPs and a combined value of the two. Also included in the summary, are the volume and pollutant load reductions provided by the BMP, in addition to the volume and pollutant loads that exit the BMP through the outflow. This outflow load and volume is what is routed to the downstream BMP if one is defined in the Watershed tab. Finally, percent reductions are provided for the percent of the performance goal achieved, percent annual runoff volume retained, total percent annual particulate phosphorus reduction, total percent annual dissolved phosphorus reduction, total percent annual TP reduction, and total percent annual TSS reduction.
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The Results tab displays all of the results from the calculated model. It summarizes the volume and pollutant reduction results based on the BMP alignment and design parameters. There are five main sections of the results section: Project Information, Site Information, Summary Information, BMP Summary, and BMP Schematic. The information displayed in the Results tab can be printed through the File menu. The print function in the File menu only activates when the Results tab is selected.
[image: ]

Example output for each of the Results tab sections are displayed below:

Project Information: The project information section of the Results tab displays all of the descriptive information of the project including project name, user name/company name, data and a project description. All of this information can be changed in the Site Information tab.

[image: ]

Site Information: The site information section of the Results tab displays information about the entire site including Volume Retention Requirement for the model, the site’s zip code, the annual rainfall amount associated with the site zip code, as well as the phosphorus EMC and TSS EMC values for the site. This information can be updated in the Site Information tab. 

[image: ]

If the Volume Retention Requirement, Phosphorus EMC and TSS EMC values are changed in the Site Information tab from the default values a red box will appear informing the user that the change was made. 
 
[image: ]

Also included in the site information section of the Results tab are a summary of the Total Site Area and the Site Areas Routed to BMPs. The Total Site Area summarizes the watershed information entered in the Site Information tab. The Site Areas Routed to BMPs totals and summarizes the watershed areas that are routed to an all BMPS in the model. These values are entered in the Watershed tab of the BMP Properties window for each individual BMP. 

[image: ]

If the watershed area in the Site Areas Routed to BMPs for a specific land use and soil type is greater than the corresponding Total Site Area, a red box and warning message will appear in the Site Areas Routed to BMPs table as shown below:

[image: ]

This warns the user that more watershed area of a specific land use type is being routed to a BMP than is in the total watershed.

Summary Information: The Summary Information section of the Results tab summarizes both the performance goal requirement as well as the annual volume and pollutant load reductions achieved by the modeled system. All five parameters (volume towards the performance goal, annual volume, dissolved P, particulate P, and TSS) are reported in terms of the amount (volume or load) created by the entire site, the amount removed by the BMPs added to the site and finally a percent removal for the entire site.
[image: ]

BMP Summary: The BMP summary tables detail BMP specific information related to the performance goal achievement, annual volume, particulate phosphorus, dissolved phosphorus, and TSS.  For each BMP the table show the volume or load received by the BMP from the direct watershed, what is received from upstream BMPs, the amount retained, the amount that leave the BMP through outflow and the percent retained.
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BMP Schematic: The BMP schematic section of the Results tab displays an image of the Schematic tab.
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When saving the model, all of the information will be stored in the Microsoft Excel version of the calculator. BMPs and model information can be changed in the Excel version and then imported into the GUI version. 
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Appendix A: BMP Parameters Tab for all BMPs
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BMP Properties: 1 - Bioretention basin (w/o underdrain)
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BMP Properties: 1 - Infiltration basin/Underground Infiltration
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BMP Properties: 1- Permeable pavement
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BMP Properties: 1- Tree trench system/Box (w/o underdrain)
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Watershed BMP Parameters | BMP Summary |

Tree trench system/Box (with underdrain)

Pecired reatmentvolume 0 f
Isthe underdirein elevated above nstive soils? E
IV‘"”’ o ("v ; A, Du)] Vg + Ve 4V, Avethe sides ofthe basin ined with an impermeable finer? =
Isthe botiom of the basin ineclvwith an impermeable liner? E
Media surface area [ Ay ] 12
Suface area ot underdrain [ Ay ] 12
Botom surtace area [Ag] 12
fiveey Total media depth [ Dy f
:I Oepn et Depth belaw underdrain [ Dy ] #
orderian @) Media el capacity -wiling point [FC-WP]range 0.05-0.17) ey
Setom o e 1) Media porosiy- field capacity [n - FCrange 0.15-0.35) e
Tree type (most common) E
Tree size (average for all trees) El
Number of rees ]
Interception capacity[IC] inches
Canopy prajection [CP] 2
Leat area index LA
Soilvolume pertres [5_V_] *
Planting media mix E

Is the P cantent of the media less than 30 ma/kg?

Is a soil amendment used to attenuate phosphorus?

Underlying soil - Hydralogic Sail Group

Infration rete of underlying soils infhr
User defined infiration refe infhr
Required drawdown fime <] hrs
Volume redluction fram basin botiom infitration [Vinf_b] e
Volume reducion from basin sides inflration [Vinf_s] 1
Volume reducian of BMP fom ET [Ver] 1
Volume reduction of BMP from interception [V)] L
Volume reduction stared belaw underdrain 1
Volume recucian capacity of BMP [V] 1
Volume of refentian provided by BMP *

SAAEIRE




image64.png
BMP Properties: 1- Swale Side Slope
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BMP Properties: 1- Swale main channel
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BMP Properties: 1- Swale main channel (with underdrain)
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BMP Properties: 1 - Harvest and re-use/Cistern
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BMP Properties: 1- Constructed stormwater pond -

Watershed BMP Parameters | BMP Summary |
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BMP Properties: 1- Other (User Defined Reductions)
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